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Updated version 
 

 

Content subject to change.  
Download the updated version: www.productselection.net 
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Important notes 
This section contains important safety-related information to be followed when installing, 

operating and maintaining the equipment. We strictly recommend respecting these rules to avoid 

damages to devices or machinery and injury or death to people. Please read this manual carefully 

before beginning any installation, maintenance or operational activity. 

 

 

•  

 

Electrical components constantly under high voltage 

•  

 

Important information for safety and to prevent physical damage 

•  

 

Important information for a proper use of the system 
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Glossary 
Sensor: Wireless sensor for detecting stationary vehicles. 

Parking bay: parking space for vehicles delimited by strips (blue, white, yellow) 

IATA: International Air Transport Association (www.iata.org) 

ISM: Industrial, Scientific, Medical. Acronym indicating free-use frequencies for low-power 

devices. 
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Introduction 
This manual describes the procedures to install and configure the SBPWSIx wireless sensors to 

detect cars in the parking bays.  

The installation procedure is divided into two parts: 

• Sensor assembly 

• Sensor installation 

This configuration procedure, carried out by using the Sensor Manager software, is explained for 

the different sensor versions. This part is divided into three parts sessions: 

• Sensor Setup: Configuring, Calibrating, Testing the sensors 

• Network configuration: Associating the sensor to the relevant concentrator/network 

• Integration into CPY Server 

 

 
See “UWP 3.0 Car Park manual” for further information about the UWP 3.0 car 
parking system integration 

 

Compliance with and observance of the instructions and recommendations included into this 

manual  will guarantee the proper functioning of the sensors and of the entire system. 
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General description  
The SBPWSIx wireless sensor is part of the Carpark system, which contains other types of 

sensors, controllers and displays. The SBPWSIx is designed to be buried under the parking bay 

and it will be completely invisible. It detects the occupied/free status of the parking bay by using 

the Earth’s magnetic field. 

We briefly describe the sensor’s operation, which will help you to understand how to use the  

Software according to the type of sensor. The sensor is an electronic device for vehicle detection, 

and it is composed of four basic elements: 

 

 

 

Element Component Function 

A Arrow indicator 
Indicates the orientation of the sensor to the direction of SBPCWSI1 concentrator 

or LoRaWAN® and NB-IoT bridges 

B Reed switch 
▪ Wakes the sensor up from “deep sleep” mode by using a magnet 

▪ Resets the sensor 

C Electronic board 

Card with a microcomputer for the management. It contains the three-axis 

magnetic field sensor, wireless chip and directional antenna for 

transmitting/receiving data packets 

D Lithium battery 

LiSoCl2 lithium battery 3.6V, the capacity is:   

SBPWSI1: 17.5/19 Ah. 

SBPWSI2: 13 Ah. 
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Radio communication 

The sensor is equipped with a radio transceiver. The sensor is available in two versions according 

to the communication protocol:  

Model Radio version 

SBPWSI1 Long Range wireless/LoRaWAN® standard 

SBPWSI2 NB-IoT 

 

 

Each model has its own available features and the properly procedures have 
to be followed to install and configure them. 

 

Sensor’s operation 

Three-axis magnetometer 

The car detection is performed using a magneto-resistive component. The total value of the 

magnitude measured by the sensor results from the sum of the value of the three individual axes 

being surveyed. 

 

In the SBPWSIx sensor two thresholds are present: a low and a high threshold. If the sensor is in 

a Vacant status (below the low threshold), to change state, the total value of the magnitude must 

be greater than the value of the upper threshold. 

 

If the sensor is in Occupied status (above the high threshold), to change state, the total value of 

the magnitude must be lower than the value of the low threshold. 

All changes that are within the two thresholds will not lead to a change in the state of the sensor. 
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Architecture (private Long Range wireless network)  

 
The SBPWSI1 sensor can be configured to transmits the parking bay status to the SBPCWSI1  
concentrator using Long Range wireless communication in a private network. The SBPCWSI1 
concentrator collects occupancy information from each SBPWSI1 sensor and transmits them, in 
real-time, to the SBP2CPY24 Server. 
 

 
 
 
 

Element Component Function 

A SBPWSI1 sensor 
Detects changes to the earth’s magnetic field caused by the presence of 
ferrous objects (cars). 

B 
SBPCWSI1 

concentrator 

Collects via long range wireless the bay status that is sent by each sensor 
in real-time. It can manage up to 100 sensors and can be positioned up to 
500 m far from the sensors. 

C 
UWP 3.0/SBP2CPY 
system 

Receives via cloud the data collected by SBPCWSI1 concentrators. The 
bay status is managed in the same way as all the other sensors (ultrasonic, 
IP camera). 
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Architecture (LoRaWAN® network) 

The SBPWSI1 sensor can be configured to transmit the parking bay status directly to a 

LoRaWAN® gateway or public network. The gateway will then send the information to the proper 

LoRaWAN® server. 

 

 

 

Element Component Function 

A SBPWSI1 sensor 
Detects changes to the earth’s magnetic field caused by the 
presence of ferrous objects (cars). 

B LoRaWAN® bridges 
Collects via standard LoRaWAN® gateways/networks/servers the 
bay status that is sent by each sensor in real-time. 
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Architecture (NB-IoT network) 

The SBPWSI2 sensor can be configured to transmit the parking bay status directly to a NB-IoT 
gateway or public network. The gateway will then send the information to the cloud Server and 
then to the CPY Server. 

 

 

Element Component Function 

A SBPWSI2 sensor 
Detects changes to the earth’s magnetic field caused by the 
presence of ferrous objects (cars). 

B NB-IoT bridges 
Collects via NB-IoT network the bay status that is sent by each 
sensor in real-time. 

C 
UWP 3.0/SBP2CPY 
system 

Receives via cloud the data collected by NB-IoT bridges. The bay 
status is managed in the same way as all the other sensors 
(ultrasonic, IP camera). 
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Safety notes 
A correct installation of the sensor is essential to guarantee the safety of pedestrians, cyclists 

and animals. The SBPWSIx sensor is installed in open and undefined parking lots, to which 

everyone can access, so that it is necessary that its installation is carried out in the best feasible 

way. Read carefully the instructions below before performing any operation. 

 

Technical environmental - Pre-requisites 

The SBPWSIx sensor must be installed inside a hole made in the existing flooring. Before 

starting the work, it is necessary to know the physical characteristics of the flooring, such as 

material, thickness of the layer to be drilled, possible presence of underground utilities within 

120 mm from the surface. 

The SBPWSIx sensor uses three-axis magnetic sensors to detect vehicles and it is therefore 

sensitive to electromagnetic fields generated by cable ducts near the sensor. It is advisable to 

request a map of electrical utilities before starting work. In the event of any passage of a conduit 

near the chosen installation point, it is advisable to modify the installation point. 

 

How to handle the sensor 

The sensor is an electronic device, and, like all electronic components, it must not be subjected 

to shocks or falls which would damage the internal oscillators and / or interrupt the circuits. 
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Preventive precautions for installation 

All personnel involved in the installation of the sensor must use appropriate PPE 

(Personal protective equipment) in compliance with Legislative Decree no. 9 April 

2008, n. 81 "Consolidated Law on Health and Safety at Work" (text coordinated with 

Legislative Decree 3 August 2009, No. 106). 

All personnel involved in the installation of the sensors or must comply with the 

recommended limits for lifting and manual transport in compliance with Legislative 

Decree no. 9 April 2008, n. 81 "Consolidated text on health and safety at work" and 

technical standard UNI ISO 11228. 

In any case and following the failure to comply with the above, Carlo Gavazzi declines all 

responsibility for any damage caused to persons and / or property during or following the 

installation of the sensors. 

 

How to store the sensor 

The sensor is an electronic device made up of an electronic part and a lithium 

battery. On some models, a procedure has been implemented to minimize the 

consumption of the sensor when it is stored. This feature allows the sensor to be 

stored for very long periods without losing battery capacity and without radio 

transmissions. Typically, this mode is present on SBPWSI1 sensors, equipped with 

Long Range wireless/LoRaWAN® type Radio. 

The sensor is equipped with a LiSoCl2 high capacity battery (see the battery details at pag.8). 

The battery is equipped with the safety protections required by the regulations, which can 

preserve the connected circuits from damage. 

The lithium contained in the batteries is highly flammable and could cause small 

explosions. Avoid shorting the battery and any contact with liquids. 

 

The storage temperature must not exceed 85°C and must not be less than -40°C. The higher 

the storage temperature, the higher will be the self-discharge of the lithium battery. The lithium 

battery cannot and should not exceed a temperature of 85°C. 
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Assembly 

Things to Know 

 

The sensor is delivered partially assembled for safety reasons due to shipping 

rules. For this reason, the sensor must necessarily have the battery 

disconnected. 

 

The shipping by air of the sensor is subjected to the IATA shipping rules with reference to 

the shipment of lithium batteries or devices containing lithium batteries. 

Refer to the www.iata.org website (e.g. webpage) or contact the carrier to obtain all the necessary 

information. 

The shipment by land or by sea, although falling within the category DGR (Dangerous Goods) is 

less restrictive than the air way. 

  

http://www.iata.org/
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Procedures 

SBPWSI1 assembly 

The sensor must be assembled and sealed before installation. It is recommended to follow the 

procedure in a lab. See the procedure below: 

 

 
 

1. Remove the lower cap and extract the sensor 

equipment 

 
2. Connect the battery to the connector on the electronic 

board 

 
 

3. Insert the sensor equipment then fix the lower cap 

 
 
 

4. Use Ms Polymer® adhesive sealant* to seal the sensor 

Note: 

* Please order it separately. Wait at least 3 hours before installing the assembled sensor into the 

ground. 
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SBPWSI2 assembly 

The sensor must be assembled and sealed before installation. It is recommended to follow the 

procedure in a lab. The SIM CARD must necessarily be inserted before sealing the sensor. See 

the procedure below: 

 

 
 

1. Remove the lower cap and extract the sensor 
equipment 

 
 

2. a) Connect the battery to the connector on the 
electronic board -b) Insert the SIM card* into the slot 

 
 

3. Insert the sensor equipment then fix the lower cap 

 
 
 

4. Use Ms Polymer® adhesive sealant** to seal the 

sensor 

Notes: 

* The SIM card is not included 

** Please order it separately. Wait at least 3 hours before installing the assembled sensor into 

the ground. 
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Sensor installation 

Things to know 

The sensor installation procedure involves a series of activities, including work to be carried out 

on public land, for the realization of the holes where the sensors have to be installed. This activity 

must be carried out in compliance with local regulations for the safety of workers and strangers 

(construction site, operational safety plan, signs, fences, etc…). 

 

Laying procedure 

 

Normally, sensor installation operations include the installation of the SBPWSIx sensors and the 

numbering of the parking bays. The activities to be performed for the installation of the sensors 

are: 

• Preparation of the sensor installation site 

• Making holes 

• Waste material removal (and subsequent disposal) 

• Preparation of the sensor installation site 

• Parking bay numbering: write down the association between bay position <-> sensor ID 

• Sensor installation 

• Sensor configuration (i.e. calibration of the sensor magnetic zero, setting of the 
communication protocol, etc..) 

 

 

Site verification 

 

The verification of the site where the sensors will be installed is a very important phase; 

in fact, the environmental and physical conditions of the place of installation must be 

evaluated to avoid detection problems.  

The presence of any electric user drains and cable ducts must be checked at the sensor 

installation points. The electromagnetic fields generated by the passage of current, in 

ducts close to the sensors, can in fact distort the detection. 
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Verification of electric/magnetic fields 

The sensor is sensitive to electric and magnetic fields to such an extent that its placement 

too close, for example, to an electric cable, can distort the reading of the vacant / 

occupied status, as it may be able to saturate the sensor transducer. Using a 

magnetometer, it is possible to check the presence of interfering electro-magnetic fields. 

Moreover, since the SBPWSI1 sensor works with the ISM band of 868 MHz, a frequency 

free to use, the presence of source of disturbances must be checked on site by means 

of a spectrum analyser, in order to detect any source of disturbance capable of affecting 

the correct communication between sensor and concentrator/network. 

 

Paving and hole 

The sensors can be installed in different types of flooring. The installer shall evaluate the proper 

solution for making the hole, such as coring, punching or drilling, according to the type of flooring. 

Asphalt: the most common condition and the easiest for both installation and maintenance. 

When the installation is complete, the highest part of the sensor must be at a height of 15/20 

mm lower than the road level. A dept of more than 20 mm may limit the radio range of the sensor. 

The hole can be made by punching the road surface, using a special tip to be applied to the 

pneumatic hammer of a medium-small excavator (+/- 1.5 tons). The tip will allow to make the hole 

the exact dimensions necessary for the installation of the sensor. 

Once the sensor has been placed and directed towards the reference 

concentrator/network/gateway, it must be fixed with sand and then covered with cold asphalt 

(15/20 mm approx.). 

Porphyry / self-blocking pavers: with this surface it is not possible to use the punching tip. If 

the flooring is laid on a soft base (e.g. sand), it is necessary to manually remove the cubes / tiles 

until an area compatible with the sensor dimensions is exposed and using a breaker or hand 

tools to create the properly sized hole. If the laying base is instead compact (cement), you can 

use a core drill to make the hole. 

Once the sensor has been placed and directed towards the reference 

concentrator/network/gateway, it must be fixed with sand and then covered with cold asphalt 

(15/20 mm approx.) or with a porphyry tile or other material, with thickness 10 / 15mm and 

adequate size and then fixed with cement. 

Cobblestone-stone: As the previous point, but finishing using cold asphalt or pieces of stone 

set with cement. 

It is not recommended to install the sensors in the presence of non-solid surfaces 

(beaten grounds, meadows, etc.).  
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Positioning of sensors 

Please follow the suggestion below to define the installation position of the sensor, according to 

parking bay type. 

Longitudinal side-by-side parking bays 

The sensor should be placed in the median line of the parking bay, at 1.25/1.5 metres from the 

head of the parking bay. 

 

 

Lineparking bays 

The sensor should be placed in the median line of the parking bay, at a distance of 1.25/1.5 

metres from the head of the parking bay. 

 



 

CP3 Outdoor –User manual 21 

 

Diagonal side-by-side parking bays 

The sensor should be placed in the median line of the parking bay, at a distance of 1.25/1.5 

metres from the head of the parking bay. 

 

 

Opposite parking bays 

 

 

 

N.B. In case of other types of parking facility or in case of doubts about the positioning of the 

sensors, please contact us.  
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Procedures 

Preliminary operation before installing 

Do not install the sensors in their final position until you have carefully read the 

information below  

 

Both the SBPWSIx sensors have a unique ID number pre-provisioned during the production 
phase. The ID number consists of 5 digits (e.g. 10123) and can be found on the label on top of 
the sensor. For each SBPWSIx sensor, this number must be changed according to the project 
and it must correspond to the parking bay number in which it will be installed. 
 
Please see the procedure below to manage the association: 
 

Step Action 

1 

Arrange a scaled map of the parking facility and number every parking bay with an individual 

number. See the indication below to number the parking bays: 

The total number of parking bays is Start the parking bays numbering with 

less than 100 101 

between 100 and 1000 1001 

higher than 1000 10001 

Assign to each parking bay the related number, in line, sequentially as shown below: 

 

  
 

Avoid the numbering as below: 
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2 

Distribute the SBPWSIx sensors over the map and write down the pre-provisioned ID number on 

the installation map matching them with the parking bays number. You should evaluate the 

preferred solution. See the example below: 

 

 

3 

Once the association is done, each SBPWSIx sensor must be physically re-addressed by using 

the Sensor Manager software. The installer should evaluate the preferred procedure, as 

proposed below on step 4a or 4b. 

4a 

This is the recommended procedure 

1- In the lab, use a permanent marker to write down the new address on the label on top of the 

sensor  

2- In the lab, Change the sensor ID. By using the Sensor Manager software, find the Sensor (it 

appears in the software with the pre-provisioned number) and change the ID according to the 

new ID that must be assigned. 

3- In the field, install the sensor on the final position according to the parking bay number in 

which it will be installed. 

4- In the field, calibrate the sensor and check that the Sensor ID is corresponding to the parking 

bay number. 

4b 

1- In the field, install the SBPWSIx sensor in the final position (do not cover it completely, the 

top of the sensor must be visible) 

2- In the field, Change the Sensor ID. By using the Sensor Manager software, find the Sensor 

(it appears in the software with the pre-provisioned number) and change the ID according to 

the new ID that must be assigned. Write-down the new address by using a permanent 

marker. 

3- In the field, Calibrate the sensor and check that the Sensor ID is corresponding to the parking 

bay number 

 

Important: Please pay close attention to the correspondence between the number of the sensor 

and the number of the parking bay. In the unfortunate event that two or more sensors were 

reversed, it will be quite problematic to understand the reasons for the failure and take the 

corrective actions.  
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Sensor installation 

The sensors must be installed into a hole made in the pavement. 

The procedure below explains how to correctly install the SBPWSIx sensor under the ground: 

Step Action 

1 Identify and mark the spot where the sensor will be installed 

2 

See the Positioning of the sensors chapter to find the best placing according to the type of 

parking lot 

 
 

3 

Use a hole-saw or other dedicated tool to drill a hole into the pavement bigger enough for the 
sensor enclosure: the hole dimensions must be as follow: 
 

 
 

4 

Try to perforate it deep enough to insert the sensor completely, without rising over the surface. Be 
sure that the enclosure remains under the pavement line at approximately 15-20 mm. 
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5 

Insert the sensor trying to orient the arrow, positioned on the upper edge of the sensor, in the 
direction of the receiver (concentrator, bridges, repeater). 
 

 

6 

Double-check that the matching between the sensor ID and the parking bay number (see 
Preliminary operation before installation procedure) is correct. 
 

 

7 

Fix the sensor by inserting it in the empty space. Use fine sand / very small stones to cover it 

completely, up to the top of sensor. 

 

Before burying them completely, these actions must be completed: 

▪ Direct the arrow towards the receiver 

▪ If the sensor has been previously set in sleep mode, it must be woken up by 

means of a magnet 

Arrow 
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8 

Seal the top of the sensor with the chosen product (cold asphalt, resin, concrete, etc.) and dust 

the surface with fine sand. 
 

If the pavement is in self-locking tiles or porphyry cubes, it is possible to cover the top of sensor 

with a little slice (10/15 mm) of the same material, fixed with concrete. 

 

 

 

When installation is completed, please refer to the Sensor Manager software 

chapter in this manual for the calibration and configuration procedures. 
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How to reset the sensor 

If the sensor has been previously set in sleep mode to preserve the battery consumption, the 

sensor sends a keep-alive packet per day only. This means that the sensor is not able to 

communicate properly with the calibration device and it does not appear in the Sensor Manager 

software interface. 

 

To reset the sensor to factory settings, or to wake it up, use a magnet as shown in the image 

below for around 5 seconds. The sensors will appear in the Not Filtered list according to the 

Sensor ID number. 

Note: if the pre-provisioned sensor ID has been changed, it will appear with the new ID number 

that has been assigned. 

 

 

 

!!This procedure must be performed before burying the sensor into its 
final position!! 

 

Arrow 
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Sensor Manager Software 
The Sensor Manager software is designed to setup, calibrate and manage the wireless sensor 

SBPWSI1 and SBPWSI2. During the sensors installation, the software can be executed in any 

PC (the SBPCAL calibration unit device is required) to communicate with sensors and manage 

them in group or individually. In addition, also the SBPCWSI1 concentrator has embedded the 

Sensor Manager software. 

 

 

▪ Free software, compatible with Microsoft Windows® 10/7 PC/Notebook 

 

▪ The same software for configuring SBPWSI1 and SBPWSI2 sensors 

 

▪ AES 128 Key management for protecting your private communication between SBPWSI1 

sensors and SBPCWSI1 concentrators 

 

▪ Real time diagnostics and advanced tools 

 

▪ Configured devices list for an easy integration into a LoRaWAN® and NB-IoT networks 
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Software installation 
Follow this procedure to download and install the software in your computer. 

Step Action 

1 
Download the Carlo Gavazzi Sensor Manager software from 
www.productselection.net 

2 Launch the Setup.exe to start the installation assistant which will guide you 

3 

Select the installation folder in your PC, then click on Next > 

 

4 

Click on Next to install the software 

 

http://www.productselection.net/
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5 

Click on Close to end the installation procedure 
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Configure the SBPCAL device 
The SBPCAL is a hand-held device designed to calibrate, test and manage the SBPWSI1 and 

SBPWSI2 wireless sensors, one by one or in group. It communicates with them via a proprietary 

Long Range wireless protocol. 

 

 

Follow the procedure below to configure and execute the Sensor Manager software: 

Step Action 

1 Connect the SBPCAL device to a Microsoft Windows 10 / 7 Computer via a USB port 
(2.0 or higher). 

2 

When the device is connected, please check if the system has installed the correct 
USB-Serial driver: 
 

▪ Automatic: the SBPCAL is automatically recognized and configured 
 

▪ Manually: Download the driver from the FTDI Internet site and install 

3 Launch the Sensor Manager software 

4 See the procedure Set COM port 

 

!!! The SBPCAL has to be connected to the PC/Notebook before the 
application launch 

  

https://www.ftdichip.com/Drivers/VCP.htm
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Set COM port 

At the software launch, it is necessary to configure the virtual COM port to be used. Follow the 

procedure below to configure the communication parameter of the connected device: 

Step Action 

1 

Click on Port tab to open the RadioSetup window: 

 

2 
In the COMM port field select the COM port that has to be used 

Note: The COM Port number vary according to the configuration 

3 Set LORA-NB-IOT in the Modulation field 

4 Set the spreading factor value in the Spr.Factor field (default value is 7) 

5 

Set Start DTR RTS (default is blank): when the device is recognized in Ver field, you 

will see a group of 4 byte (e.g. 01-80-72-4A). This means the SBPCAL device is 

properly set. 

6 

Should the device not be detected (the Ver field is blank): 

 

Turn the selector OFF  

7 In the Start DTR o RTS field select one of the three options available 

8 Turn the selector OFF  

9 Repeat steps 6 to 8 untill in the Ver. Field appears 

10 

You can enable a WatchDog (WD) in case the Sensor Manager does not receive any 

radio packet in the range of time. This will reset the device radio module when the time 

expires. 
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Things to know 

Start DTR o RTS 

The connection of the SBPCAL device to a PC/Notebook depends on how the serial converter is 

set in the PC, some PC requires to set the DTR option, other PC requires to enable the RTS 

options and other PC requires to enable nRTS. The user has to try different configurations to find 

the correct one as shown in the procedure above. 

 

Spreading factor 

Like in a standard wireless system, the higher the number of devices and transmitted data, the 

higher the possibility of interferences is. In that case, you need to extend the transmission interval 

to guarantee the reliability.  

To obtain the maximum distance and the interference resistance, we suggest using the SF7 

spreading factor. Spreading factors other than SF7 is not suggested and should be evaluated 

by the installer according to the environmental condition since higher Spreading Factor value 

should not guarantee the correct data transmission.  
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Sensor configuration 
Once the SBPWSIx sensors have been installed in their final position, they are ready to be 

configured by means of the Sensor Manager software. 

In this chapter are presented the quick start procedures to configure the sensors, according to 

the different communication protocols. These procedures show the steps the installer has to follow 

to install and configure the sensors properly. 

For any additional configuration requirements, the installer can go through the detailed 

procedures in this manual. 

For any type of application other than those shown below, please contact Carlo Gavazzi.  

 

Quick start procedures 

 

Do not bury the sensors completely, until you have carefully read the information 

below. 

 

1. Before configuring the sensors, read carefully the Sensor Installation chapter on this 

manual. 

 

2. The sensors have to be installed in their final position according to the parking bays 

numbering as defined by the project specifications. This means that the ID number has to 

be set/changed for each SBPWSI1 sensor according to the numbering position as defined 

in the project map. See Set/change the sensor ID number procedure for further details. 

Below, the procedures are explained for the different sensor versions: 

 

Version Procedure 

SBPWSI1 

Long Range Wireless 

 

SBPWSI2 NB-IoT 
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Set the private Long Range Wireless 

To set the SBPWSI1 sensors and the SBPCWSI1 concentrator to communicate using the Long 

Range wireless protocol, follow the procedure below: 

Step Action 

1 
Install the SBPCWSI1 concentrator  
 

See the SBPCWSI1xxx Installation manual available on productselection.net for further details. 

2 

Place all the SBPWSI1 sensors into their parking bay position. It is recommended to bury them 
completely only when the entire procedure has been completed. 
 

See the Sensor Installation chapter for further details. 

3 
In the Options tab of the Sensor Manager software, check that ACK Automatic (FILTERED) 
and ACK Automatic (NOT FILTERED) are disabled.  
See ACK Automatic OFF for further details. 

4 
Wait until all the SBPWSI1 sensors appear in the Not Filtered list. 
N.B.: They must appear with their valid ID numbers according to the parking bay numbering 
defined in the project specifications. 

5 Select the sensors that have to be configured and move them to the Filtered list. 

6 

In the Basic Settings tab, send the following commands: 
 

▪ Set Date Time 
▪ Calibration 

7 

By using a metallic object (such as a toolbox, a drill, etc...), check that each sensor changes 
status (from vacant to occupied). 
 

Note: you can check the sensor status in real-time in the Show -> Status filtered sensor window. 

8 

To set the Long Range wireless protocol, click on Sensor Manager Crypt key tab and click on 
Create AES128 Key: a popup will appear with a new generated key: 
 

 
 

Click on OK button to copy it to the clipboard. 
 

Please save the generated key in a safe place (e.g. Microsoft Excel file, a database) before 
proceeding!! 

 

9 

In the Network Configuration window, click on Long Range Wireless button, then click on Send 
AES 128 Key button to insert the generated AES128 key. 
 

 
 

Click on the OK button to save the changes. This operation only stores the value into the sensors. 

http://www.productselection.net/
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10 

In the Network Configuration window, select the Long Range Wireless option then click on 
Activate AES 128 button: in the popup that appears enter the 1 value: 
 

 
 

Click on the OK button: the AES128 end-to-end communication will be activated as soon as the 
command is executed (see the Status command window). 

11 
Once the AES 128 key is enabled in the selected sensors, the communication with the SBPCAL 
device will be interrupted. The sensors are ready to be associated to the related SBPCWSI1 
concentrator. 

12 

Power on the SBPCWSI1 concentrator and access to the system by using the provided 
TeamViewer / Anydesk ID and password. 
 

N.B: the credentials are provided by Carlo Gavazzi according to the concentrator serial number 
(each SBPCWSI1xxx unit has dedicated access parameters). 

13 
The concentrator has embedded the Sensor Manager software. 
In the Options tab check that ACK Automatic (FILTERED) and ACK Automatic (NOT 
FILTERED) are disabled. 

14 

To enable the end-to-end communication with the sensors, click on Sensor Manager Crypt 

key tab and click on Set AES128 button. In the Select Keys window select Custom option: 
 

 

15 

Insert the previously generated key in the Crypt Key 128 bit field: 
 

This must be the same key that has been set in the SBPWSI1 sensors (as shown 
in the steps 8-9 above). 
 

 
 

Click on Save and Quit button: the AES 128 end-to-end communication will be enabled between 
the sensors and the concentrator. 

16 
Wait until all the SBPWSI1 sensors appear in the Not Filtered list then select them and move to 
the Filtered list. 



 

CP3 Outdoor –User manual 37 

 

17 

In the Internet tab, click on Server Udp setup option: The Remote Setup window appears. 
 

 
 

Click on the Save button to store the changes 

18 

In the Internet tab, select the UDPFlow option: in the window that appears you can check the 
communication status to the Cloud server. 
 

Note: for any communication issue, please contact Carlo Gavazzi 

19 

Once the communication is working properly, in the Options tab make sure the ACK 
Automatic (FILTERED) option is enabled. See ACK Automatic ON for further details. 
 

 
 

20 

To complete the setup procedure in the concentrator, in the File tab click on the Save Filtered 
default option. 
 

 
 

21 
As soon as the Connection to the Cloud server has been established, contact Carlo Gavazzi for 
the Cloud configuration.  

22 
You will receive back the parameters to access the Cloud:  access the CPY server and add the 
cloud parameters. 

  

ATTENTION!!  

The user is responsible for the generation and the store of the encryption key. If the encryption 

key is lost and/or forgot, it will not be possible to add and make the maintenance of the sensors, 

and in case of failure of the SBPCWSI1 concentrator, it will not be possible to replace it without 

the AES128 key. Should this happen, all the sensors must be unburied, reset by means of a 

magnet and reprogrammed with a new AES 128 key. 

  

▪ In the UDP Remote address field 

enter the value 52.166.220.173 

(related to Carlo Gavazzi Cloud 

server) 

 
▪ In the UDP Remote port field enter 

the value 8792 (related to Carlo 
Gavazzi Cloud server) 
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Set the LoRaWAN® communication protocol 

N.B.: This manual does not describe the configuration of LoRaWAN network servers nor 

the configuration of LoRaWAN application servers. 

The procedure below delivers the information to configure the SBPWSI1 sensors according to the 

standard LoRaWAN® gateways. 
 

Things to know 

LoRaWAN® is a Low Power Wide Area Network (LPWAN) protocol. It is a spread-spectrum 

modulation technique at extremely low data-rates, which permits sending data achieving long 

ranges. As required by LoRaWAN® protocol,  an authentication method, such as OOTA or ABP 

mode, must be set between the SBPWSI1 sensors and LoRaWAN servers. This means that the 

LoRaWAN® service provider must provide the required information. 

 

OTAA join mode 

Over-the-Air Activation (OTAA) is the preferred and most secure authentication method. Sensors 

perform a join-procedure with the LoRaWAN® network, during which a dynamic DevAddr is 

assigned and security keys are negotiated with the device. The following parameters are required 

by the OTAA join mode: 

Parameter Description 

DevEUI 

The device EUI of the sensor is pre-provisioned during production and can be found on the 
printed label on top of the SBPWSI1 sensor. Each sensor has a unique DevEUI. See the 
example below: 
 

 
You might communicate the DevEUI of all the SBPWSI1 sensors to the LoRaWAN service 
provider. 

AppKey 
The AppKey is provided by the LoRaWAN® service provider. The same AppKey must be 
set both in the sensors and in the LoRaWAN server. 

AppEUI 
The AppEUI is provided by the LoRaWAN® server provider. If you have your own AppEUI, 
you can also add this to your configuration. The same AppEUI must be set both in the 
sensors and in the LoRaWAN network server. 

 

  

https://www.thethingsnetwork.org/docs/lorawan/security.html#security-keys
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ABP (Authentication By Personalization) 

The following parameters are required by the ABP join mode: 

Parameter Description 

DevEUI 

The device EUI of the sensor is pre-provisioned during production and can be 
found on the printed label on top of the sensor. 
 

 
 

DevAddr 

These keys are provided by the LoRaWAN® service provider. The same keys must be set 
both in the sensors and in the LoRaWAN server. 

NwkSKey 

AppSKey 

 

If you are interested in further information about LoRaWAN® specifications, please refer to the 

LoRa® Alliance specifications document. 

 

Procedures 

To set the SBPWSI1 sensors according to the LoRaWAN® communication protocol, follow the 

procedure below: 

Step Action 

1 
Place all the SBPWSI1 sensors into their parking bay position. 
 

See the Sensor Installation chapter for further details 

2 
In the Options tab of the Sensor Manager software (via the SBPCAL device), check that ACK 
Automatic (FILTERED) and ACK Automatic (NOT FILTERED) are disabled.  
See ACK Automatic OFF for further details. 

3 

In the Sensor Manager software wait until all the SBPWSI1 sensors appear in the Not Filtered 
list. 
N.B.: They must appear with their valid ID numbers according to the parking bay numbering 
defined in the project specifications. 

4 Select the sensors that have to be configured and move them to the Filtered list. 

5 

In the Basic Settings tab, send the following commands: 
 

▪ Set Date Time 
▪ Calibration 

6 

By using a metallic object (such as a toolbox, a drill, etc...), check that each sensor changes 
status (from vacant to occupied). 
 

Note: you can check the sensor status in real-time in the Show -> Status filtered sensor window 
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7 

In the Network Configuration window, select the Set LORAWAN Parameters option: 
 

 

8 

In LoRaWAN Parameters, click on the LWan UseCases button to open the UseCases menu: 
select OTAA or ABP according to the settings of the LoRaWAN® network server you are 
connecting the sensors to: 
 

▪ OTAA Solution 3 
▪ ABP Solution 2 

 

 
 

9 Click on the Save and Quit button to store the changes. 

10 

Set the parameters according to the selected join methods as required by the LoRaWAN® network 
server you are connecting the sensors to: 
 

Authentication Then you need to set... 

OTAA Solution 3 

▪ Click on the Set AppKey OTAA button to enter the AppKey 
provided 

 

▪ Click on the Set AppEUI button to set the provided AppEUI. 
  If you do not have your AppEUI, you can enter the value: 

0101010101010102 

ABP Solution 2 

▪ Click on the Set AppSKey ABP button 
▪ Click on the Set NwkSKey ABP button 
▪ Click on the Set DevAddr button 

 

  to enter the provided keys 
 

Important note: enter the values without spaces or dashes! 

11 
In the Status Command window, check that all the sent commands have been executed before 
activating the LoRaWAN® communication protocol for the selected sensors. 

12 

After having set all the LoRaWAN® parameters, make sure that all the sensors that have to be 
activated with the LoRaWAN communication are selected, then click on Set Long Range 
wireless/LoRaWAN® button: the communication protocol will be immediately switched to 
LoRaWAN®.  
N.B: They will disappear from the Sensor Manager since they start to communicate to the 
LoRaWAN® network. 
This setting is saved into the memory of the sensor, so it will be restored after a battery 
disconnection. 

https://context.reverso.net/traduzione/inglese-italiano/without
https://context.reverso.net/traduzione/inglese-italiano/dashes
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Set back to Long Range Wireless 

To set the SBPWSI1 sensors back to the Long Range wireless mode, there are two ways: 

Procedure Description 

a 
Disable the ACK message in the LoRaWAN® network: after about 1 hour and 20 
minutes, if the sensors do not receive any ACK from the LoRaWAN® network, they will 
return to the Long Range wireless mode 

b 

Reset the sensors: Move a magnet close to the reed switch for a few seconds to reset 
the sensors. After this reset operation, the sensors will restart in Long Range wireless 
mode.  
Note: this operation must be done when the sensors are powered. 

 

After a change in the communication protocol, the sensors will appear in the Not Filtered list. 
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Set the NB-IoT communication protocol 

To set the SBPWSI2 sensors according to the NB-IoT network parameters, follow the procedure 

below. 

Note: A SIM card must be installed into each SBPWSI2 sensor (see SBPWSI2 assembly), 

before proceeding with the following procedure. 

Step Action 

1 
Place all the SBPWSI2 sensors into their parking bay position. 
 

See the Sensor Installation chapter for further details 

2 
In the Options tab of the Sensor Manager software (via the SBPCAL device), check that ACK 
Automatic (FILTERED) and ACK Automatic (NOT FILTERED) are disabled.  
See ACK Automatic OFF for further details. 

3 
In the Sensor Manager software, wait until all the sensors appear in the Not Filtered list. 
N.B.: They must appear with their valid ID numbers according to the parking bay numbering 
defined in the project specifications. 

4 Select the sensors that have to be configured and move them to the Filtered list. 

5 

In the Basic Settings tab, send the following commands: 
 

▪ Set Date Time 
▪ Calibration 

6 
By using a metallic object (such as a toolbox, a drill, etc...), check that each sensor changes 
status (from vacant to occupied) as shown in the Sensor filtered status window. 

7 

In the Network Configuration window, select the Set NBIOT Parameters option: 
 

 

8 
In the Set PLMN (MCC+MCN) field, set the PLMN of the SIM provider (a 5 digit number).  
 

Example: TIM IT value is 22201 
 

9 

In the Destination Platform field enter the value to set the destination platform: 
 

0 Carlo Gavazzi Cloud server 

1 Other destination server 
 

10 

In the Set IP field enter: 
 

52.166.220.173 Carlo Gavazzi Cloud server 

[IP address] Other destination server 
  

11 

In the SET Port field: 
 

8792 Carlo Gavazzi Cloud server 

[UDP port] Other destination server 
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12 

In the APN LOW field, set the APN of the ISP. 
 

Example: TIM IT APN value is nbiot.tim.it 
 

N.B.: Please verify with the ISP, if the APN is necessary for their NB-IoT solution. It might happen 
that the operator asks for the APN, but the sensors are not able to register in the network. 

13 
In the Set Code City field, enter the provided value 
 

N.B.: if this value is not provided by the ISP, leave it blank. 

14 
In the Status Command window, check that all the sent commands have been executed before 
activating the NB-IoT communication protocol for the selected sensors. 

15 

After having set all the NB-IoT parameters, make sure that all the sensors that have to be 
activated for NB-IoT communication are selected, then click on the Set Long Range 
wireless/NbIot mode button: the communication protocol will be immediately switched to NB-
IoT network.  
N.B: They will disappear from the Sensor Manager since they start to communicate to the 
NB-IoT network. 
 

This setting is saved in the memory of the sensor, so it will be restored after a battery 
disconnection. 

 

Set back to maintenance mode 

To return the SBPWSI2 sensors to Long Range Wireless, there are two ways: 

Procedure Description 

a 
Disable the ACK message in the NB-IoT network: after about 1 hour and 20 minutes, if 
the sensors do not receive any ACK from the NB-IoT network, they will return to the 
Long Range wireless mode 

b 

Reset the sensors: move a magnet close to the reed switch for a few seconds to reset 
the sensors. After this reset operation, the sensors will restart in Long Range wireless 
mode.  
Note: this operation must be done when the sensors are powered. 

 

After a change in the communication protocol, the sensors will appear in the Not Filtered list. 
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User interface 
In this chapter the different menus and their related procedures are presented. 

File tab 

In the File tab the installer can manage the projects. 

 

The available fields are the following ones: 

Field Description 

Save Filtered default 
To save the current configuration of the detected sensors and to propose it 

to the forthcoming opening of the program 

Load Filtered default To open a saved sensors configuration 

Exit To close the Sensor Manager software 
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Port tab 

This menu shows the parameters for a specific network. The options showed depend on the 

chosen Modulation. 

 

In the picture above, LORA-NB-IOT modulation is selected and the parameters are referred to 

this modulation. The available fields are as follows: 

Field Description 

COMM port Indicates the Serial Port in use 

Modulation Indicates the sensors modulation such as Long Range wireless/NB-IoT 

Spr.factor Selects the Spreading Factor value for Long Range wireless/LoRaWAN® modulation  

WD mode Sets Watch Dog. Note: It requires the RTS field set to ON 

WD Minutes After xx minutes without any reception activity, the Sensor Manager will be reset 

RX OK Shows the total number of received messages  

RX error Shows the total number of communication errors 

Last RX Shows the last sensor ID received 

Last RSSI Shows the RSSI of the last received frame 

Ver Shows the SBPCAL firmware version  

Err Shows the error messages 
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Management tab 

In the Management menu it is possible to clear all the counters and reset the Sensor 

Management without exiting the program. 

 

 

Options tab 

In the Options menu it is possible to set the following parameters: 

 

The available options are as follows: 

Field Description 

ACK Automatic 

(FILTERED) 

If selected, an ACK message is sent to all the sensors present in the table 

FILTERED, after they have sent a frame. 

ACK Automatic  

(NOT FILTERED) 

If selected, an ACK message is sent to all the sensors present in the table 

NOT FILTERED, after they have sent a frame. 
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Things to Know 

 

Set… ACK Automatic ON ACK Automatic OFF 

when… 

▪ the sensors and the receiver are properly 

configured 

▪ the system is up and running 

▪ the commissioning has to be carried out 
 

▪ the sensors have to be managed 

+ Low battery consumption The commands will be executed immediately 

- The commands will be executed slowly High battery consumption 

 

ACK Automatic ON 

When the ACK Automatic option is ON → an ACK (acknowledge message) is required by the 

sensor: this means that the SBPCWSI1 must send back to the sensor an ACK as a receipt of 

each received message in the following situations: 

▪ The bay status changes → the sensor sends an info message to the concentrator 

▪ The bay status does not change → the sensor sends a Keep-Alive message when the 

Keep-Alive timeout expires 
 

▪ When the sensor receives the ACK, it will operate in IDLE MODE until the next event to optimize 

the battery consumption. 

▪ If the concentrator/calibration unit sends a command to the sensor, it will be executed at 

the next event (KA timeout expires, change of status). 

 
 

In IDLE MODE the sensor sends a KA message only when the timeout expires, but it notifies 

immediately any change detected in the bay status.  
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ACK Automatic OFF 

During commissioning → the ACK Automatic option must be set to OFF: the sensor doesn’t 

expect any ACK, so it immediately reacts to any command (the only delay is due to the Sample 

time). 

▪ The sensor receives a command → this will be executed according to the Sample time (default 

10 s) instead of the Keep-Alive timeout (default 10 min) 

 

If during commissioning the ACK Automatic is ON: 

  the command will be executed at the next event (change status detected or KA message 

forwarding), slowing down the setup operations. 

 

 

 

As soon as the commissioning is finished, the ACK Automatic options must be set to ON. 
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Show tab 

In this menu the installer can enable/disable dedicated windows to manage the sensors and 

their communication, as well as commands and diagnostic information. 

 

 

Sensors List window 

The Sensor List shows all the active sensors received by the SBPCAL/SBPCWS1. From this 

window the installer can perform the commands to the selected sensors. 

 
 

The available areas are as follows: 

Area Description 

Not filtered list In this area all the discovered sensors will be shown. 

Filtered list 
The installer has to move in the Filtered list all the sensors that have to be 

managed in the current project. 

Commands 

Basic Settings 

Advanced Settings 

Network Configuration 

Firmware Updates 

Note: Commands can be executed only for sensors that are present in the Filtered list 
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Command List 

The commands available are grouped in four sub-tabs as follows: 

 

Basic Settings 

 

The available field are as follows: 

Field Description 

Calibration To calibrate the magnetic zero of the sensors. 

Address Set To modify the address ID (number) of the sensor. 

Auto ACK 

To enable the sensors to give themselves an ACK after n attempts. This 

option is useful to prevent the battery lifetime (disabled by default on brand 

new sensors). 

Set Date Time To send an update of date and time to the sensor, using the PC setting. 

Clear CMD To clear any queued command not executed yet. 
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Procedures 

Select the sensors to be managed 

To send commands to one or more sensors, they have to be moved to Filtered list. See the 

procedure below: 

 

Step Action 

1 
Connect the SBPCAL device to a PC/Notebook where the Sensor Manager software is up and 

running. 

2 
Select the correct radio modulation and the spreading factor value (if it differs from the default 

one). 

3 
Open the Sensor List window from Show tab and wait for the list of sensors to appear in the 

Not Filtered list. 

4 

From the Not filtered list, select the sensors: they will be highlighted in blue. 

Click on > button to move them to Filtered list. 

 
Tip: You can click on >> button to move all the available sensors. 

5 

From the Filtered List, select the sensor(s) to which the commands have to be sent. 

 

6 Click on [command] (e.g. Calibration, Address Set) button to execute it. 
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Calibration 

The calibration should be performed when the sensor is fully installed and ready for its 

final use! 

Thing to know 

Magnetic Zero Calibration 

The calibration process must be carried out once the sensors are installed. No cars or other metal 

objects such as tools or fences must be present in a radius of 5 meters from the sensor (best 

condition), otherwise the calibration might not be properly done, affecting the detection of cars. 

 

 
 

Calibrate the sensors 

After you have installed the sensors, and when the area is clear of cars, follow this procedure: 

Step Action 

1 
Connect the SBPCAL device to a PC/Notebook where the Sensor Manager software is 
up and running. 

2 Select the correct radio modulation and channel (if it differs from the default one). 

3 

Open the Sensor List window from Show tab and wait for the list of sensors to appear 
in the Not Filtered column. 

 
Note: to send/receive commands, such as Calibration, the sensors must be present in 
the Filtered List. 
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4 

Move to the Filtered List column the sensors which need to be calibrated. They will be 
highlighted in blue. 

 
 
Note: please do not select more than 10 sensors at a time 
 

5 

Click on Calibration button and click on Yes button to confirm the operation. 

 

6 

In the StatusCommand window that appears, you can check the execution of always the 
commands: 
 

 
 
▪ On the left, the pending commands are shown together with the sensors information. 
▪ On the right, the executed commands are shown.  

7 
If everything is done according to the procedure, the calibration of a group of 10 sensors 
require up to 60 seconds. 
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Set date and time 

This command updates the internal clock of the SBPWSIx sensors according to the table below: 

Device Clock  

SBPCAL The PC clock value 

SBPCWSI1 The SBPCWSI1 clock value 

 

It is important to do this operation every time a sensor is installed and calibrated. See the 

procedure below: 

Step Action 

1 From the Filtered list, select the sensors: they will be highlighted in blue. 

2 Click on button Set Date Time in the Basic Setting menu. 

 

Set/change the sensor ID number 

To set/change the physical address of a sensor, follow the procedure as follows: 

Note: This procedure must be done for one sensor at a time. 

Step Action 

1 
From the Filtered list, select the sensor: it will be highlighted in blue 
If the sensor is present in the Not Filtered list, move it to the Filtered list 

2 Click on Address Set button in the Basic Setting menu 

3 

In the window that opens, write the new address number: 
 

e.g.: in the example below the predefined number 10002 is changed to 101 
 

 
 

Click on OK button to send the command 
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4 

As soon as the procedure is finished, the Sensor will appear in the Filtered list within 
the new ID number. At the first packet received with the new id, the FW version will be 
displayed on the right of the new sensor ID. 
 
e.g: in the example below, the old ID was 10002 and the sensor is now present with the 
new ID 101  
 

 
 

5 

The “old” ID is still present in the Filtered list. It is recommended to move it from the 
Filtered list to Not Filtered list, to avoid confusion. 
 

 
 

 

 

Clear the commands 

If it is necessary to send again the same command to a sensor, it is required to clear the 

sent/executed command for the selected sensors, by pressing the button Clear CMD. 

If you need to send again the same command to a sensor or a group of sensors, you must delete 

the pending commands. Otherwise, the same command will not be added to the Queued/Pending 

list. Follow the procedure below: 

Step Action 

1 From the Sensors List window select the SBPWSIx sensor(s) in the Filtered list 

2 Click Clear CMD from Basic settings menu 
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Set AutoACK property 

Thing to know 

N.B: In the example below, the SBPCWSI1 concentrator is set to ACK Automatic always ON. 
 

▪ If the communication between the concentrator and the sensor is momentarily down, the 

sensor will not receive any ACK message. 

▪ If the AutoACK parameter is OFF → the sensor will continue to retry the transmission until 

it receives an ACK. Since the sensor is always active, the battery consumption will be very 

high 

▪ If the AutoACK parameter is ON → the sensor will acknowledge itself after n replies (min.1 

– max. 7) stopping the continuous transmission to prevent the battery from discharge 

 

 

When the communication returns up and running, the sensor will receive back the ACK from the 

concentrator. 
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Procedure 

To Set the AutoACK option in the Sensor settings, follow this procedure: 

Step Action 

1 In the Filtered list, select one or more sensors. They will be highlighted in blue. 

2 

In the Basic settings click on Auto ACK button: the following message appears: 
 

 
 
Click on Yes button to enable Auto ACK functionality. 
Click on No button to disable the Auto ACK functionality. 

3 

If you have select Yes, in the next popup, insert the number of max. retries (min. 1 max. 
7): 
 
 

 
 

Click on OK button to store the changes. 
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User Interface 

Advanced Settings 

 

The available fields are as follows: 

Field Description 

Sample Time To set the sampling time of the sensor (factory setting is 10 seconds) 

Kalive Time 
To set the keep-alive message time in seconds (factory setting 600 

seconds – 10 minutes) 

Retries Time 
To set the retries interval in case the sensor does not receive any ACK 

(factory setting is 10 seconds) 

Threshold Low To set the threshold below which the sensor returns the Occupied status 

Threshold High To set the threshold above which the sensor returns the Vacant status 

*Debounce Busy 

To set the waiting interval within which the sensor must always detect the 

Occupied status, before sending the message to the server 
 

*This feature is useful to prevent the sensor send occupied messages, when a 

vehicle is only in transit or manoeuvring. 
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Network Configuration 

Long Range Wireless 

In this menu the installer can set the Long Range Wireless parameters to link the SBPWSI1 

sensors to the relevant SBPCWSI1 concentrator(s). 

 

The Long Range Wireless parameters are as follows: 

Field Description 

Send AES 128 Key To set an AES128 key to the selected SBPWSI1 sensors 

Activate AES 128 
To enable the AES128 end-to-end communication between the 

selected sensor and their related SBPCWSI1 concentrator 
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Set LoRaWAN® Parameters 

In this menu the installer can set the LoRaWAN® parameters to configure the SBPWSI1 sensors 

to the relevant LoRaWAN® network. 

 
 

The LoRaWAN® parameters are as follows: 

Field Description 

LWan UseCases 

To set the join method for a LoRaWAN® network: 

▪ OTAA 

▪ ABP 

Set AppKey To set the AppKey for OTAA join 

Set AppSKey To set the AppSKey for ABP join 

Set NwkSKey To set the NwkSKey for ABP join 

Set DevAddr To set the DevAddr for ABP join (0x AABBCCDD) 

Confirmed Rate 

To set the confirmed messages after n sent messages (depends 

on the LoRaWAN® gateway setup) Please refer to the LoRaWAN® 

service provider 

Set AppEUI To set the AppEUI for OTAA join 

Set Long Range 

wireless /LoRaWAN® 

Mode 

To switch from Long Range wireless (maintenance) to LoRaWAN® 

radio protocol. 
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Set NBIOT Parameters 

In this menu the installer can set the NB-IoT parameters to configure the SBPWSI2 sensors 

according to NB-IoT network. 

 

The NB-IoT parameters are as follows: 

Field Description 

Set PLMN 

(MCC+MCN) 
To set the 5 digits Operator Code 

Set IP To set the destination IP address of the server 

Set Port To set the destination UDP port in the server 

Dest Platform 

To set the destination platform: 

▪ Carlo Gavazzi Cloud server or; 

▪ 3rd party platform 

APN LOW To set the APN of the network 

Get IMEI NB-IoT To receive the IMEI of the SBPWSI2 radio device  

Set Code City 
To set a different Code City (numeric value) to be sure that the 

sensors information will be received in the correct platform. 

Get IMSI To receive the IMSI of the SIM of a sensor 

Set Long Range 

wireless/NB-IoT Mode 
To switch the sensor from Long Range wireless to NB-IoT network 
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Firmware Updates 

With this menu, it is possible to load a new firmware to upgrade a SBPWSIx sensor. To upgrade 

the firmware, follow this procedure: 

Step Action 

1 

Click on Load Firmware Memory button 
 

 

2 Select the firmware file 

3 

Click on Firmware Upd to Sensor button to start the process 
To avoid radio collisions, since the FW upgrade requires over 1000 packets, we 

suggest performing the FW upgrade for one or two sensors at the same time. 

4 Check in the Status Filtered Sensor window the upgrading process. 
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Show -> Filtered Sensors 

Select the Filtered Sensors option to enable a window to monitor the frames received from the 

sensors that are present in the Filtered.  

 

Show -> Not filtered Sensors 

Select the Not Filtered Sensors option to enable a window to monitor the frame received from 

the sensors that are present in the Not Filtered.  

 

For both the windows, the available buttons are as follows: 

Button Description 

Debug To enable the view of frames in byte format 

Pause To stop the update of the window 

Scroll To enable the vertical scroll of the window 

Clear To clear the window  

Copy To copy the contents of the window in the clipboard 

Close To close the window 
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Show -> Commands sent 

In this window all the commands are shown , executed and/or aborted from the SBPWSIx 

sensors. Every command sent to the sensor will open the Command sent window, where on the 

left the pending commands are shown, and on the right the executed commands. In this way it is 

very simple to understand when a sensor has received a command or a configuration. 

 

 
 

The available areas are as follows: 

Area Description 

Queued/Pending 
Commands 

It shows the pending commands that have already been sent to the sensors 

Executed 
Commands 

It shows the executed commands 

Aborted 
Commands 

It shows the aborted commands 

 

Things to know 

Aborted command 

If after 10 attempts, a command sent to a SBPWSIx sensor has not been executed, this will be 

aborted by the Sensor Manager. See Clear commands procedure to send the command again. 
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Show -> Single Sensor Monitor 

This window shows all the radio communications of a single sensor. Digit the sensor number in 

the box close to the buttons in the bottom side of the window. The button functions are the same 

of the Filtered and Not Filtered windows. 

 

 

Show -> Status Filtered Sensors 

It shows a window where it is possible to select which data the user wants to display for all the 

sensors that are present in the Filtered List. 
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On the left menu it is possible to select the data displayed in each sensor box. The available 

options are as follows: 

Field Description 

Address It shows the ID number of the sensor 

Version It shows the firmware version 

Rx RSSI It shows the quality of radio signal of the sensor 

Upload In case of FW upgrade, it shows the number of frames left to complete it 

Last RX It shows the TimeStamp of the last sensor frame 

First RX 
It shows the TimeStamp of the first sensor frame received in the current 

session 

Last Date It shows the last Date received from the sensor 

Magnitudo 
It shows the value of the magnitude received from the sensor in the last 

received frame 

Last MSG It shows the type of the last frame received (Vacant/Occupied/Kalive) 

Msg/Retry 

It shows the number of frames received in the current session and 

number of retries (with this data it is simple to understand the quality of 

the radio coverage, few retries = high quality, many retries = poor quality) 

N.Changes 
It shows the number of status changes (Free / Busy) received in the 

current session 

Pending It shows the commands in pending status (in sending queue) 

RadioReset It shows the number of automatic resets done by the sensor 
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Sensor Manager Crypt Key tab 

In this menu the installer can set the AES128 end-to-end key between the SBPWSI1 sensors and 

the SBPCWSI1 concentrator. 

N.B: It is strongly suggested to set the AES128 key prior to complete the full installation process. 

 

The available options are as follows: 

Button Description 

Set the AES128 

Key 

To enable/disable the AES128 end-to-end communication in the SBPWSI1 

concentrator: 
 

Option Description 

Factory 

(default) 

Select this option to set the communication without any key. 
Note: this option should not be selected since the 
communication could not be protected 

Custom 
Select this option to set and enable the AES128 end-to-end 
communication according to the provided AES 128 key 

 

Create an AES128 

key 

To randomly generate a new AES128 key to be used between the SBPWSI1 

sensors and the SBPCWSI1 concentrator 

 

Important notice 

!!! THE GENERATION AND THE STORE OF THE AES 128 KEY IS RESPONSIBILITY OF THE 

USER !!! 
 

THE SAME AES 128 KEY MUST BE SET IN THE SBPCWSI1 CONCENTRATOR AND IN THE 

SBPWSIx SENSORS. PLEASE STORE IT IN A PROPER WAY. 
 

For security reasons, the Sensor Manager software does not allow to see or retrieve the AES 128 

key in use. 
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Internet tab 

Note: This menu is shown ONLY in the Carlo Gavazzi Sensor Manager software version 

that is running in the SBPCWSI1 concentrator. 

In this menu the installer can configure the parameter related to the Carlo Gavazzi Cloud server 

to which the SBPCWSI1 concentrator will send the occupancy information collected from the 

SBPWSI1 sensors. 

 
 

The available options are as follows: 

 

Field Description 

Send Information 
It enables the Sensor Manager to send the occupancy information 
collected by the sensors to Carlo Gavazzi Cloud server 

Force TX to Server It forces the concentrator to send the information to the Cloud server 

Remote Server 

Setup 

It sets the details of the Cloud server: 
 

Field Description 

IDGATEWAY 
It Shows the MAC Address or IMSI of the 
SBPCWSI1 concentrator 

UDP Remote 

Address 
To set the IP Address of the Carlo 
Gavazzi Cloud server 

UDP Remote port To set the UDP Port of the Cloud Server 

UDP Local Port 
It shows the standard value. 

Note: do not change this value 

Kalive send 

interval 

Set the keep-alive interval value (default 

value is 20) 

Kalive send 

Threshold 

Set the keep-alive threshold value (default 

value is 20)20 
 

UDP Flow 

It shows the flow of the communication between the SBPCWSI1 

concentrator and the Cloud server. This diagnostic window is useful 

to test the communication from the concentrator to the Cloud server 

Sensor from Server 
To enable the Sensor Manager to receive the sensor list from the 

Server 
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